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Before You Begin
Before You Begin
This section provides you with safety information, technical support 
information, and sources for additional product information.

Safety Information
Your safety is extremely important. Read and follow all warnings and 
cautions in this document before handling and operating Intermec 
equipment. You can be seriously injured, and equipment and data can 
be damaged if you do not follow the safety warnings and cautions.

This section explains how to identify and understand dangers, 
warnings, cautions, and notes that are in this document. You may also 
see icons that tell you when to follow ESD procedures and when to 
take special precautions for handling optical parts.
   

Global Services and Support
Warranty Information
To understand the warranty for your Intermec product, visit the 
Intermec web site at www.intermec.com and click Support > 
Returns and Repairs > Warranty.

A warning alerts you of an operating procedure, practice, 
condition, or statement that must be strictly observed to avoid 
death or serious injury to the persons working on the equipment.

A caution alerts you to an operating procedure, practice, 
condition, or statement that must be strictly observed to prevent 
equipment damage or destruction, or corruption or loss of data.

Note: Notes either provide extra information about a topic or contain 
special instructions for handling a particular condition or set of 
circumstances.
viii SR61B Cordless Scanner User’s Guide
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Before You Begin
Web Support
Visit the Intermec web site at www.intermec.com to download our 
current manuals (in PDF).

Visit the Intermec technical knowledge base (Knowledge Central) at 
www.intermec.com and click Support > Knowledge Central to 
review technical information or to request technical support for your 
Intermec product.

Send Feedback
Your feedback is crucial to the continual improvement of our 
documentation. To provide feedback about this manual, please 
contact the Intermec Technical Communications department directly 
at TechnicalCommunications@intermec.com.

Telephone Support
In the U.S.A. and Canada, call 1-800-755-5505. 

Outside the U.S.A. and Canada, contact your local Intermec 
representative. To search for your local representative, from the 
Intermec web site, click About Us > Contact Us.

Service Location Support
For the most current listing of service locations, go to 
www.intermec.com and click Support >Returns and Repairs > 
Repair Locations.

For technical support in South Korea, use the after service locations 
listed below:

AWOO Systems
102-1304 SK Ventium
522 Dangjung-dong
Gunpo-si, Gyeonggi-do Korea, South 435-776
Contact: Mr. Sinbum Kang
Telephone: +82-31-436-1191
E-mail: mjyun@awoo.co.kr
SR61B Cordless Scanner User’s Guide ix
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Before You Begin
IN Information System PTD LTD
6th Floor
Daegu Venture Center Bldg 95
Shinchun 3 Dong
Donggu, Daegu City, Korea
E-mail: jmyou@idif.co.kr or korlim@gw.idif.co.kr

Who Should Read This Manual
This SR61B Cordless Scanner User’s Guide is for the person who is 
responsible for installing, configuring, and maintaining the SR61B 
Cordless Scanner. 

This SR61B Cordless Scanner User’s Guide provides you with information 
about the features of the SR61B Cordless Scanner, and how to install, 
configure, operate, maintain, and troubleshoot them.

Before you work with the SR61B Cordless Scanner, you should be 
familiar with your network and general networking terms, such as IP 
address.

Related Documents
The Intermec web site at www.intermec.com contains our 
documents (as .pdf files) that you can download for free.

To download documents
1 Visit the Intermec web site at www.intermec.com.

2 Click the Products tab.

3 Using the Products menu, navigate to your product page. For 
example, to find the CN3 computer product page, click 
Computers > Handheld Computers > CN3.

4 Click the Manuals tab.

If your product does not have its own product page, click Support > 
Manuals. Use the Product Category field, the Product Family field, 
and the Product field to help you locate the documentation for your 
product.
x SR61B Cordless Scanner User’s Guide
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Before You Begin
Patent Information 
There may be U.S. and foreign patents pending.
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Introducing the SR61B Cordless 
Scanner
Use this chapter to familiarize yourself with the SR61B 
Cordless Scanner. This chapter covers these topics:

• What is the SR61B Cordless Scanner

• Charging the Battery

• Turning On the SR61B

• Understanding the SR61B Behavior

• Scanning Bar Codes

• Accessories
1



Chapter 1 — Introducing the SR61B Cordless Scanner
What is the SR61B Cordless Scanner
The SR61B Cordless Scanner is a rugged purpose-built handheld 
scanner with an ergonomic design. It uses a Bluetooth™ radio for RF 
communications.

SR61B Cordless Scanner

The SR61B is available in the following models:

• 1D linear imager—SR61B1D-xxx

• Laser scanner—SR61BL-xxx

• Extra range area imager—SR61BXR-xxx

• High performance 2D area imager—SR61BHP-xxx

• High Density / DPM—SR61BDPM-xxx

SR61B Scan Engine Option: The scan engine option of your SR61B is the first 
part of the configuration number. In this illustration, the model is SR61BHP-
XXX for 2D area imager.

Battery

Intermec
Ready-to-Work
indicator

Status
light

Scanner

Trigger

SR61BHP-XXX

SN: XXXXXXXXXXX 
  CN: SR61BHP-XXX 

Intermec Technologies Corp.

Contains FCC ID: QOQWT41
IC: 5123A-BGTWT41

IC:ICES-003 CLASS B
XXXXXXX

BDA: XXXXXXXXXXXXXXXXX
5V  1,7AIntermec Scanner Technology Center

MODEL, MODELO,        ,         : SR61B
MFD,                  ,              : YYYYMMDD
2 SR61B Cordless Scanner User’s Guide



Chapter 1 — Introducing the SR61B Cordless Scanner
For more information about the scanner options, see “Scanning Bar 
Codes” on page 8.

Charging the Battery
The SR61B uses a lithium-ion battery as its main power source. You 
need to fully charge the battery before you can use the SR61B.

Make sure you fully charge the battery before you start using the 
SR61B.

To charge the battery
• Place the SR61B with the battery installed in the desktop/wall 

mount 1-bay charger (AC5). 

Or,

• Remove the battery from the SR61B, and insert the battery into 
the 2-bay, 4-bay, or 8-bay (AC6, AC7, or AC8) charger.

For more information, see “Required Accessories” on page 12.

Checking the Battery Status
The SR61B status light automatically displays a low battery signal 
(blinking red) when less than 20% of the battery capacity remains. If 
so, you need to charge the battery. 

Status light signals are different when the scanner is docked in a 
charger. For more information, see “Status Light” on page 6.

The battery pack used in this device may ignite, create a chemical 
burn hazard, explode, or release toxic materials if mistreated. Do 
not incinerate, disassemble, or heat above 100°C (212°F). Charge 
only with Intermec Models AC5, AC6, AC7, and AC8 (see “SR61 2-
Bay, 4-Bay, or 8-Bay Charger” on page 13). Do not short circuit; 
may cause burns. Keep away from children.

Use only Intermec battery pack Model AB3 (P/N 075082-xxx). Use 
of incorrect battery pack may present risk of fire or explosion. 
Promptly dispose of used battery pack according to the 
instructions.
SR61B Cordless Scanner User’s Guide 3



Chapter 1 — Introducing the SR61B Cordless Scanner
Turning On the SR61B
The following procedure decribes how to turn on the SR61B.

To turn on the SR61B
• Pull and release the trigger.

The SR61B beeps 2 times and vibrates at power-up by default. 

It enters a discoverable state and remains discoverable for about 5 
minutes (before automatically shutting off, can be configured). While 
the SR61B is discoverable and in communications range, your host 
Bluetooth device can discover your SR61B and establish a Bluetooth 
connection. 

If your SR61B is already connected to a Bluetooth device (blue 
Intermec Ready-to-Work indicator on), it is not discoverable.
4 SR61B Cordless Scanner User’s Guide



Chapter 1 — Introducing the SR61B Cordless Scanner
Understanding the SR61B Behavior
The SR61B uses lights, beeps and vibrations to indicate if a bar code 
has been successfully decoded. The lights and beeps described in this 
section are new and do not correspond to the legacy SR61B models 
(SR61BV, SR61BA, SR61BL or SR61BE).

Intermec-Ready-to-Work Indicator
The Intermec-Ready-to-Work indicator ™ (blue LED) gives 
information about the Bluetooth connection. When a connection has 
been established the light is always on (blue) unless the scanner is 
docked in a charge base. In this case the blue light turns off even 
though the Bluetooth connection is still active.

When using your scanner to scan bar codes (blue light on) your 
scanner will also flash status information using green or red lights. 
See the Status Light information in the next section.

Note: If you prefer to use the legacy beep and LED mode you can 
activate the legacy mode using EasySet. For information on using 
EasySet see “Configuring Your Scanner with EasySet” on page 31.

Blue Intermec Ready-to-Work Indicator

Light State What it Means

Off A Bluetooth connection has not been established.
OR
Scanner is docked in a charge base.

Blinking, slow The scanner is trying to establish a Bluetooth 
connection with a Bluetooth device.

Blinking, fast The scanner is awaiting user acknowledgement in a 
pairing procedure.

On A Bluetooth connection to the base station or host 
computer is established. The SR61B is ready to scan 
bar codes and send data.
SR61B Cordless Scanner User’s Guide 5
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Status Light
The status light flashes green or red to indicate the status of the 
scanner and/or battery. Status information is sometimes shown even 
if the Intermec Ready-to-Work Indicator is on. This way the scanner 
can communicate more than one type of information at the same 
time. 

For example while the blue LED is on to show that there is a 
Bluetooth connection, the scanner will flash green when you have 
successfully scanned a bar code.

Default Status Light Description

Light State What it Means

Green light on for 2 
seconds

The scanner successfully decoded a bar code and sent 
the data to the host.

Green light flashes 2 
times

A configuration bar code was successfully read.

Red light on for 2 
seconds

Transmission error
OR
Configuration bar code was not accepted

Red, blinking slow Battery power is low (< 20% - need to charge).

Red, on
(only when docked)

The scanner is charging.

Green, on
(only when docked)

Battery is fully charged.

Red, blinking fast Battery fault.
6 SR61B Cordless Scanner User’s Guide



Chapter 1 — Introducing the SR61B Cordless Scanner
Beeps and Vibrate Alert
The SR61B beeps to give you audio feedback and vibrates when 
performing some functions. For example, you hear a beep each time 
you scan a valid bar code.

Using Vibrate Alert
You can configure the SR61B to vibrate when it successfully decodes a 
bar code. This feature can be useful in these situations:

• You are in a noisy environment, such as a busy warehouse, where it 
can be difficult to hear the beep. 

• You are working in a quiet environment, such as a library, where 
you do not want to make a lot of noise.

Default SR61B Beep and Vibrate Alert Descriptions

Beep Sequence What it Means

Single beep The SR61B successfully scanned a bar code. 

Two fast beeps and 
vibrates

Power-up.

Two fast beeps The SR61B successfully scanned a configuration bar 
code

Two beeps, bitonal The SR61B is docked correctly in the SR61B Charge 
Base.

Six very fast beeps Transmission error
OR
Configuration bar code was not accepted

Series of beeps 
from low to high

The SR61B is connecting to a Bluetooth host.

Series of beeps 
from high to low

The SR61B is disconnecting from a Bluetooth host.
Note: The scanner does not beep when disconnecting 
automatically after a long period of inactivity.

Six-beep melody Scanner confirmation after rescue procedure (see 
“Rescuing the SR61B” on page 49).
SR61B Cordless Scanner User’s Guide 7
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To turn on vibrate alert
• Scan this bar code:

Turn On Vibrate Alert

To turn off virate alert
• Scan this bar code:

Turn Off Vibrate Alert

Scanning Bar Codes

The SR61B contains either a 1D linear imager (SR61B1D), 2D area 
imager (SR61BHP, SR61BDPM), laser scan engine (SR61BL), or near-
far range area imager (SR61BXR) to scan bar code data. The type of 
scan engine you are using and the type of bar code you are decoding 
determines the way you scan the bar code.

When you unpack the SR61B, these bar code symbologies are enabled: 

• Code 39

• Code 128 / GS1-128

• EAN/UPC

• PDF417 (SR61BL, SR61BHP, SR61BDPM and SR61BXR only)

• DataMatrix (SR61BHP, SR61BDPM and SR61BXR only)

For the SR61BL, SR61BXR, SR61BHP, SR61BDPM do not look 
directly into the window area or at a reflection of the laser beam 
or laser aiming beam while the laser is scanning. Long-term 
exposure to the laser beam can damage your vision.
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If you are using bar code labels that are encoded in a different 
symbology, you need to enable the symbology on your SR61B. Use 
EasySet version 5.6.5.3 or later to enable and disable symbologies for 
your scanner. EasySet is available on the Intermec web site at 
www.intermec.com.

Before you can scan bar codes and send data to your data collection 
application, you need to establish a Bluetooth connection between 
your SR61B and the host device. If your scanner is not connected it 
will emit an error beep when scanning bar codes. For more 
information about establishing a Bluetooth connection, see 
“Connecting the SR61B” on page 17.

To scan a bar code label with an SR61BL or SR61B1D
1 Turn on your scanner by pressing the trigger.

2 Connect your scanner to a Bluetooth device.

3 Point the SR61B at the bar code label and hold the SR61B at a 
slight angle 5 to 10 cm (2 to 4 in) from the label. 

4 Pull the trigger, and direct the red beam so that it falls across all 
bars in the bar code label. 

Use this test bar code:

Code 39 Test Bar Code

*123456*
*123456*

Tip: Depending on your screen resolution, you may be able to scan 
bar codes displayed on your computer screen except with SR61BL 
(laser imager). Print out and scan bar codes with the SR61BL.

When the SR61B successfully reads a bar code label, the SR61B 
beeps one time, the status light briefly turns green, and the 
scanner beam turns off. If Vibrate Alert is enabled, the SR61B 
briefly vibrates.

5 Release the trigger.
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Scanning Bar Codes: The aiming and scanner beams that you see depend
on which SR61B model you are using.

To scan omni-directionally with the SR61BHP, SR61BDPM or SR61BXR
1 Point the scanner window at the bar code label and hold the 

SR61B steady a few inches from the label.

2 Pull the trigger.

• If you are scanning with one of the 2D imagers, use the laser 
framing to position the imager over the bar code or area to 
capture.

SR61BHP and SR61BDPM Laser Framing

• If you are scanning with a near-far range area imager 
(SR61BXR) at a near distance (< 30 cm / 11.8 in), position the 

ABCD

Status light

ABCDABCD

30°

20°
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red aiming beam just to the right of the center of the bar code 
label.

SR61BXR Aiming Beam

3 When the SR61B successfully reads a bar code label, the SR61B 
beeps one time, the status light briefly turns green, and the 
scanner lighting turns off. If Vibrate Alert is enabled, the SR61B 
briefly vibrates.

4 Release the trigger.

bar code 
center axis 
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Accessories
There are several different accessories available. Here you will find a 
list of required and optional accessories.

Required Accessories
You will need the following battery and one of the following chargers 
for your SR61B.

SR61 Desktop/Wallmount 1-Bay Charger
The SR61 desktop/wall mount 1-bay charger (Model AC5) is used to 
charge the SR61B without removing the battery from the scanner.

For more information, see the SR61 1-Bay Charger Instructions shipped 
in the box.

SR61 Desktop/Wallmount 1-Bay Charger: P/N 825-901-xxx
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SR61 2-Bay, 4-Bay, or 8-Bay Charger
The SR61 2-Bay (Model AC6, P/N 852-907-xxx), 4-Bay (Model AC7, 
P/N 852-908-xxx), or 8-Bay Chargers (Model AC8, P/N 852-902-xxx) 
are used to charge the AB3 batteries (P/N 075082-xxx) that power 
SR61B scanners.

For more information, see the IP30 / SR61 Multibay Battery Charger 
Instructions shipped in the box.

SR61 2-Bay, 4-Bay, or 8-Bay Charger: P/N 852-907-xxx, 852-908-xxx or 852-
902-xxx

Optional Accessories
The following accessories are optional.

SD61 Base Station
The SD61 Base Station is used to connect up to seven Intermec 
cordless Bluetooth™ scanners to a non-Bluetooth host device. 

For more information see the SD61 Quick User’s Guide on the Intermec 
web site at www.intermec.com.
SR61B Cordless Scanner User’s Guide 13
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SD61 Base Station: P/N 3-231019-xxx

SR61 Dangle Suspension
The SR61 dangle suspension (P/N 825-181-xxx) provides you with a 
convenient way to secure the SR61B Cordless Scanner to your vehicle 
or work station.

For more information see the SR61 Dangle Suspension Instructions 
shipped in the box.

SR61 Dangle Suspension: P/N 825-181-xxx
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SR61 Belt Holster
The SR61 belt holster (P/N 825-179-xxx) provides you with a 
convenient way to carry the SR61B Cordless Scanner when you are 
not using it. 

For more information see the SR61 Belt Holster Instructions shipped in 
the box.

SR61 Belt Holster: P/N 825-179-xxx

SR61 Wrist Strap
The SR61 wrist strap provides you with a convenient way to keep the 
SR61B Cordless Scanner securely hanging from your wrist when 
you’re not using it.

SR61 Wrist Strap: P/N 825-184-xxx
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Connecting the SR61B
Use this chapter to understand how to connect the SR61B to a 
number of Bluetooth devices. This chapter covers these topics:

• Introducing SR61B Bluetooth Connections

• Connecting the SR61B to an Intermec Computer

• Connecting the SR61B to an Intermec SD61 Base 
Station

• Connecting the SR61B to Other Bluetooth Devices

• Connecting the SR61B as a Keyboard Wedge
17



Chapter 2 — Connecting the SR61B
Introducing SR61B Bluetooth Connections
You can use Bluetooth radio communications to connect up to seven 
SR61B scanners to the following devices:

• Intermec computers that are Bluetooth-enabled

• Intermec SD61 Base Station

• Other Bluetooth-enabled devices that support Serial Port Profile 
(SPP) or Human Interface Device Profile (HID)

The SR61B can also be connected as a keyboard wedge to a Bluetooth-
enabled host PC via an Intermec software, SmartWedgeLite™.

Before connecting the SR61B to a host device, note the Bluetooth 
address for the:

• Host Bluetooth device

• SR61B

SR61B Bluetooth Address: The SR61B Bluetooth address is located on the 
scanner label.

To connect to a host device, you may need to install EasySet, the 
Intermec configuration application that allows you to change settings 
on the SR61B. For the SR61B, you need EasySet version 5.6.5.3 or 
later. You can download EasySet at no charge from the Intermec web 
site at www.intermec.com.

Bluetooth device address

SN: XXXXXXXXXXX 
  CN: SR61BHP-XXX 

Intermec Technologies Corp.

Contains FCC ID: QOQWT41
IC: 5123A-BGTWT41

IC:ICES-003 CLASS B
XXXXXXX

BDA: XXXXXXXXXXXXXXXXX
5V  1,7AIntermec Scanner Technology Center

MODEL, MODELO,        ,         : SR61B
MFD,                  ,              : YYYYMMDD
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Out of Range Behavior
If the Bluetooth connection is lost (out of range, scanner battery too 
low, etc.) the scanner will automatically try to reconnect once the 
problem is resolved (back in to range, recharge scanner battery, etc.). If 
you try to read a bar code while the scanner is disconnected from the 
host, the scanner will emit an error beep.

Connecting the SR61B to an Intermec Computer

1 Turn on the SR61B by pulling the trigger.

2 Scan the Bluetooth association bar code label that ships with your 
Intermec computer. If you do not have a Bluetooth association bar 
code label for your Intermec computer, use EasySet to create a 
Bluetooth connect bar code. For help, see the EasySet software.

Tip: Depending on your screen resolution, you may be able to scan 
this bar code displayed on your computer screen.

The SR61B beeps twice, the green status light flashes twice, and 
the blue Intermec Ready-to-Work™ indicator starts blinking. On 
your Intermec computer, the Authen. Request dialog box appears.

3 In the Enter PIN field, enter the default PIN (0000) and select OK. 

When the SR61B connects to your Intermec computer, the SR61B 
emits a series of beeps from low to high, and the blue Intermec 
Ready-to-Work indicator turns on and stays on. The SR61B is 
ready to scan data.

Note: When you first connect to an Intermec computer, only 
SR61B settings common to the Intermec computer’s 
internal scanner settings are changed to the internal 
scanner’s default settings.
SR61B Cordless Scanner User’s Guide 19



Chapter 2 — Connecting the SR61B
4 Repeat Steps 1 to 3 to connect up to seven scanners to the 
Intermec computer.

Connecting the SR61B to an Intermec SD61 Base 
Station

You can connect up to seven Intermec Bluetooth scanners to the 
SD61 Base Station.

To connect up to 7 scanners
1 Connect the SD61 base station to a host device using the correct 

cable for your interface (see the SD61 Base Station User’s Guide 
available on our website at www.intermec.com).

2 With an Intermec Bluetooth scanner, scan the association bar code 
on the top of the SD61 Base Station. If you do not have a 
Bluetooth association bar code label for your base station, use 
EasySet to create a Bluetooth connect bar code. For help, see the 
EasySet software.

The scanner beeps twice, the green status light flashes twice and 
the blue Intermec Ready-to-Work indicator starts blinking. When 
the scanner connects to the base station it emits a series of beeps 
from low to high. The blue Intermec Ready-to-Work indicator 
turns on and stays on for both the scanner and base station. 

3 To add more scanners, repeat steps 1 and 2.

Note: You can also use the Intermec Bluetooth Scanner Wizard on the 
Intermec computer. For help, see the documentation for your 
Intermec computer.
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Connecting the SR61B to Other Bluetooth 
Devices

The cordless SR61B scanner can communicate with a host device 
through the Bluetooth communications Human Interface Device 
Profile (HID) and Serial Port Profile (SPP).

HID Bluetooth Device Connection
With the HID profile, your SR61B is recognized as a keyboard. 
Connection information is stored, meaning that if the scanner loses 
connection (out of range, low battery, etc.), it will try to reconnect as 
soon as possible (back into range, charged battery, etc.). Moreover, no 
specific software is needed in HID profile as opposed to SPP profile to 
collect data.

Before trying to pair and connect your scanner, make sure:

• it is not already trying to establish a Bluetooth connection. If so, 
the blue Intermec Ready-to-Work indicator blinks; read the 
Bluetooth device disconnect bar code.

Bluetooth Device Disconnect

• it is not already paired with your Bluetooth device. If so, remove it 
from your host’s Bluetooth devices list.

• your host is set to allow Bluetooth device connections.

Pairing and Connecting as an HID Bluetooth Device
This section describes how to pair and connect your scanner from 
your host PC.

To pair and connect as an HID Bluetooth device
1 Turn on your scanner by pulling the trigger.

2 Scan the Bluetooth device profile - HID configuration bar code

Bluetooth Device Profile - HID
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3 Double-click the Bluetooth icon on your taskbar. The Bluetooth 
Devices listing all paired devices window appears.

4 Click on the command for adding a Bluetooth device (Add or Add 
a device depending on operating systems). The wizard for adding 
Bluetooth devices appears.

5 Follow the onscreen instructions until your host searches for 
Bluetooth devices. The SR61B scanner appears in the Bluetooth 
device list as a keyboard in the following format: SR61B - BDA, 
where BDA is the scanner’s Bluetooth Device Address.

You can find the BDA on the scanner’s label.

6 Select your scanner and validate.

7 If a PIN is required (depending on your host operating system and 
Bluetooth version), enter the default Bluetooth PIN (0000) and 
validate. 

Your scanner automatically connects to the host: it emits a series 
of beeps from low to high, and the blue Intermec Ready-to-Work 
indicator turns solid blue.

Note: If the scanner does not appear in the list, it might be already 
paired with the host. Under some operating systems, already 
paired Bluetooth devices do not appear in the Bluetooth device 
search list.

Note: A pairing confirmation can be enabled. If so, the blue Intermec 
Ready-to-Work indicator starts blinking rapidly at this stage, 
indicating that the scanner is awaiting acknowledgement. Pull the 
trigger to complete the pairing procedure.
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SPP Bluetooth Device Connection
The SPP profile allows your SR61B to use the Bluetooth link as a 
serial port to communicate with your host device. If you are using an 
application working with serial ports, you do not need to modify it to 
collect data with the SR61B.

Before connecting your scanner you must first pair it to your host. 
Then you can connect your scanner to your host by initiating the 
Bluetooth connection either from your SR61B scanner (incoming 
connection) or from your host (outgoing connection):

• A scanner-initiated connection (incoming) requires reading a 
Bluetooth association bar code then opening the incoming port 
from an application such as a terminal emulation program.

The advantage of this method is that the scanner automatically 
tries to reconnect to the host each time the connection is lost.

This method is recommended for collecting data in your data 
collection software.

• A host-initiated connection (outgoing) requires opening the 
outgoing port from an application such as EasySet or a terminal 
emulation program.

The advantage of this method is that no Bluetooth association bar 
code is required. However, if the connection with the host is lost, 
you must re-connect using the connection procedure.

This method is recommended for setting up your scanner online 
using EasySet.

Before trying to pair or connect your scanner, make sure:

• it is not already trying to establish a Bluetooth connection. If so, 
the blue Intermec Ready-to-Work indicator blinks; read the 
Bluetooth device disconnect bar code.

Bluetooth Device Disconnect

• it is not already paired with your Bluetooth device. If so, remove it 
from your host’s Bluetooth devices list or skip the pairing step.

• your host is set to allow Bluetooth device connections.
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Pairing as an SPP Bluetooth Device
This section describes how to pair your scanner from your host PC.

To pair as an SPP Bluetooth device
1 Turn on your scanner by pulling the trigger.

2 Scan the Bluetooth device profile - SPP configuration bar code.

Bluetooth Device Profile - SPP (*)

3 Double-click the Bluetooth icon on your taskbar. The Bluetooth 
Devices window appears.

4 Click on the command for adding a Bluetooth device (Add or Add 
a device depending on operating systems). The wizard for adding 
Bluetooth devices appears.

5 Follow the onscreen instructions until your host searches for 
Bluetooth devices. The SR61B scanner appears in the Bluetooth 
device list in the following format: SR61B - BDA, where BDA is the 
scanner’s Bluetooth Device Address.

You can find the BDA on the scanner’s label.

6 Select your scanner and validate.

7 If a PIN is required (depending on your host operating system and 
Bluetooth version), enter the default Bluetooth PIN (0000) and 
validate. 

Your scanner is now paired with your host. Two virtual Standard 
serial ports over Bluetooth link (incoming and outgoing) are 
created.

Note: If the scanner does not appear in the list, it might be already 
paired with the host. Under some operating systems, paired devices do 
not appear in the Bluetooth device search list.

Note: A pairing confirmation can be enabled. If so, the blue Intermec 
Ready-to-Work indicator starts blinking rapidly at this stage, 
indicating that the scanner is awaiting acknowledgement. Pull the 
trigger to complete the pairing procedure.
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8 Note the COM port numbers and port type (incoming, outgoing) 
for example by opening the Bluetooth settings from the Bluetooth 
icon in the taskbar or the operating system Device Manager.

Connecting from your Host as an SPP Bluetooth Device
This section describes how to perform a host-initiated connection, for 
example prior to setting up your scanner online using EasySet.

To connect from the host
1 Once your scanner is paired with your host, turn it on by pulling 

the trigger. Make sure it is set as an SPP Bluetooth device.

2 Start EasySet version 5.6.5.3 or later. Make sure that SR61B is 
selected as your product.

3 Select Communication > Select communication interface. The 
Device Selection dialog box appears.

4 Select the outgoing COM port (Standard Serial over Bluetooth 
link) that you noted at the end of the pairing procedure and click 
OK.

5 Depending on the time elapsed since your last connection or if 
your scanner has been reset since pairing, a pop-up might appear, 
indicating that a Bluetooth device is trying to connect.

6 If so, click on the pop-up. A window appears asking for the pairing 
code. Enter the default Bluetooth PIN (0000) and validate.

When the scanner connects to your host PC, it emits a series of 
beeps from low to high, and the blue Intermec Ready-to-Work 
indicator turns solid blue.

7 To disconnect from EasySet, select Communication > 
Disconnect.

When the scanner disconnects from your host PC, it emits a series 
of beeps from high to low, and the blue Intermec Ready-to-Work 
indicator turns off.

Note: You can also connect your scanner to your host from any 
terminal emulation program by opening the required port.
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Connecting from your Scanner as an SPP Bluetooth 
Device
This section describes how to perform a scanner-initiated connection, 
for example prior to collecting data.

To connect from the scanner
1 Once your scanner is paired, turn it on by pulling the trigger. Make 

sure it is set as an SPP Bluetooth device.

2 Start EasySet version 5.6.5.3 or later. Make sure that SR61B is 
selected as your product.

3 Select the Interface > Bluetooth > Connect/disconnect folder.

4 Double-click on the Compose BT address command. A 
Bluetooth - Connect/disconnect - Compose BT address 
window opens.

5 Compose your host Bluetooth Device Address (BDA) and click 
OK. The Bluetooth association bar code is created.

6 Print and read the Bluetooth association bar code. The blue 
Intermec Ready-to-Work starts blinking.

7 Open the incoming port that you noted at the end of the pairing 
procedure, for example from a terminal emulation program.

When the scanner connects to your host PC, it emits a series of 
beeps from low to high, and the blue Intermec Ready-to-Work 
indicator turns solid blue.

8 To disconnect, close the incoming port.

When the scanner disconnects from your host PC, it emits a series 
of beeps from high to low, and the blue Intermec Ready-to-Work 
indicator turns off. The LED starts blinking.
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Connecting the SR61B as a Keyboard Wedge
You can connect your SR61B to your host PC in SPP profile as a 
keyboard wedge using a dedicated Intermec software, 
SmartWedgeLite. 

Connecting as a keyboard wedge lets your host PC receive data from 
the SR61B as it would from a keyboard. This can be useful if you do 
not want to set your scanner as an HID Bluetooth device and still 
collect data in your business applications.

Before connecting your scanner using SmartWedgeLite, make sure:

• your host PC is Bluetooth-enabled,

• your scanner is set as an SPP Bluetooth device,

• your host PC has SmartWedgeLite installed.

To connect your scanner as a keyboard wedge using SmartWedgeLite
1 Start SmartWedgeLite.

SmartWedgeLite main screen

Note: You can download SmartWedgeLite at: 
http://intermec.custhelp.com/app/answers/detail/a_id/13629/
kw/smartwedgelite
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A connection barcode appears at the bottom of the main screen 
based on your host Bluetooth device BDA (Bluetooth Device 
Address).

2 Connect your scanner either by:

• reading the association bar code displayed on the 
SmartWedgeLite application main screen with your scanner.

This is a scanner-initiated (or incoming) connection. If your 
scanner later loses connection to your host PC, it will 
automatically try to reestablish it.

• clicking on Scanners > Add scanner (or the  icon), then by 
choosing your scanner in the list of Bluetooth devices which 
opens or by checking Type in manually the bluetooth 
address of my scanner and entering your scanner BDA 
address.

Both methods are host-initiated (or outgoing) connections. If 
your scanner later loses connection to your host PC, you will 
need to follow this procedure again to reestablish Bluetooth 
connection.

Host-initiated connection: Choosing your scanner in a list of detected 
Bluetooth devices
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Host-initiated connection: Typing manually your scanner Bluetooth Device 
Address.

When the scanner connects to your host PC, it emits a series of beeps 
from low to high, the blue Intermec Ready-to-Work indicator turns 
solid blue and the scanner is added to your list of connected scanners.

An arrow indicates whether:

• the connection is incoming  or outgoing ,

• the connection is operational (green arrow) or in fault (red arrow).

Connected scanners and connection statuses: Here, one operational incoming 
connection and one failing outgoing connection.
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To disconnect your scanner, for example to connect it to an Intermec 
computer or to another Bluetooth-enabled host, click on Scanners > 
Remove scanner (or the  icon). You can also select the scanner in 
the list and press Del.

Note: For more information about SmartWedgeLite, see the 
application embedded help or online help at http://
intermec.custhelp.com/app/answers/detail/a_id/13629/kw/
smartwedgelite.
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Configuring the SR61B
Use this chapter to understand how to configure the SR61B to 
communicate with your application. This chapter covers these 
topics:

• Basic Setup with Configuration Bar Codes

• Configuring Your Scanner with EasySet

• Configuring your Scanner From Your Intermec 
Computer
27
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Basic Setup with Configuration Bar Codes
This section provides you with configuration bar codes for a basic 
setup of your scanner. It also gives the procedure for configuring your 
scanner offline or online using EasySet.

All default values are marked with (*).

Resetting Your Scanner
To reset your scanner, read the reset factory defaults configuration 
bar code.

Reset factory defaults

Setting an International Keyboard
By default the SR61B uses a North American keyboard layout. Use 
these configuration bar codes to select the keyboard for your country. 
Additional keyboards are available in EasySet (see “Configuring 
Your System with EasySet” on page 31).

North American Windows (*)

French Windows

French Canadian Windows 95/98
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French Canadian Windows XP/2000

German Windows

Spanish Windows

Italian Windows

UK English Windows

Japanese Windows

Brazilian Portuguese Windows

Czech Republic Windows

Slovakian Windows

Hungarian 101-key
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Configuring the Postamble
The default postamble is <CR> <LF>. For certain applications or 
when using your scanner as an HID Bluetooth device you may need to 
change this setting. Use the following configuration bar codes to 
change the default postamble in your scanner.

Carriage Return + Line Feed (*)

None

Carriage Return

Enter
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Configuring Your Scanner with EasySet
EasySet is an Intermec configuration application that provides you 
with two ways to configure your scanner.

• Online setup—send configuration commands from EasySet 
directly to the product.

• Offline setup—send configuration commands to a bar code setup 
sheet, print the setup sheet and use a connected scanner to scan 
the bar codes.

EasySet is available on the Intermec web site at www.intermec.com/
EasySet. Simply download and install.

Online Setup with EasySet
Online setup with EasySet is available for your scanner only if it is 
connected to your host as an SPP Bluetooth device (outgoing 
connection).

To configure your scanner online by sending commands from EasySet
1 Connect the scanner as an SPP Bluetooth device to a host PC (see 

“SPP Bluetooth Device Connection” on page 23).

2 Start EasySet. The first time you start EasySet, the Select product 
dialog box appears.

If the Select product dialog box does not appear, choose Product > 
Select or click on the product icon in the upper left corner.

3 Select your product (SR61B).

4 Select Communication > Select communication interface. The 
Device Selection dialog box appears.

5 Select the communication interface that you are using for your 
scanner and click OK.

6 EasySet connects to your scanner and retrieves the current 
configuration. These configurations are indicated with a blue 
check mark or blue text. Open the folders to find the 
configuration commands needed. Double click each command to 
send it to the scanner.
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Offline Setup with EasySet
To configure your scanner offline by scanning bar codes

1 Start EasySet. The first time you start EasySet, the Select product 
dialog box appears.

If the Select product dialog box does not appear, choose Product > 
Select or click on the product icon in the upper left corner.

2 Select your product (SR61B).

3 Open the folders to find the configuration commands needed. 
Double-click each command to send each command to the setup 
sheet.

4 Click on the print icon to print out the setup sheet and scan the 
commands.

Configuring your Scanner From Your Intermec 
Computer

You can configure many settings for the SR61B from your Intermec 
computer using Intermec Settings.

To configure the SR61B from your Intermec computer
1 Establish a Bluetooth connection with your Intermec computer 

(see “Connecting the SR61B to an Intermec Computer” on 
page 19).

2 On your Intermec computer, start the Intermec Settings 
application.

3 Select Data Collection > SR61 Scanner Bluetooth Address, where 
Bluetooth Address is the Bluetooth address of your SR61B. The 

Note: The scanner does not beep when you send configuration 
commands online from EasySet. It powers off when you select 
Disconnect from the Communication menu in Easyset.

Note: When you first connect to an Intermec computer, only SR61B 
settings common to the Intermec computer’s internal scanner settings 
are changed to the internal scanner’s default settings.
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SR61B Bluetooth address is located in the top right corner of the 
label on the side of the SR61.

4 Configure commands from the SR61 Scanner menu for your 
SR61B.

5 Select File > Save Settings. The SR61B is updated with the new 
configuration command settings.

6 Close Intermec Settings.
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Troubleshooting and Maintaining the 
SR61B
Use this chapter to solve problems you may have while using 
the SR61B. This chapter contains these topics: 

• Troubleshooting the SR61B

• Maintaining the SR61B
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Troubleshooting the SR61B
If you have problems using the SR61B, use this chapter to find a 
possible solution.

Calling Product Support
To talk to an Intermec Product Support representative:

• In the U.S.A. and Canada, call 1-800-755-5505

• Outside the U.S.A. and Canada, contact your local Intermec 
representative. For help, go to www.intermec.com > About Us > 
Contact Us.

Before you call Intermec Product Support, make sure you have the 
following information:

• SR61B firmware version

• SR61B decode version

• SR61B sub-system version

To get the firmware version and decode version
1 Run an application that can accept bar code information from the 

SR61B:

• If you are using your SR61B scanner as a keyboard (for example 
if it is connected through a SD61 Base Station with a USB 
Keyboard HID or keyboard wedge interface, or if it is 
connected to a Bluetooth device as an HID Bluetooth device), 
use Microsoft® Notepad.

• If you are using your SR61B scanner as a serial device (for 
example if it is connected through a SD61 Base Station with an 
RS-232 or USB Virtual Com interface, or if it is connected to a 
Bluetooth device as an SPP Bluetooth device), use the EasySet 
ISCP Terminal window.

2 Scan one of these bar codes:

Get firmware version
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Get decode version

Get sub-system version

Problems and Possible Solutions
Use this section to find possible solutions to problems you may have.

Problems and Possible Solutions 

Problem Possible Solution

You pull the trigger, but 
nothing happens.

The SR61B is powered by a rechargeable lithium-
ion battery. Make sure the battery is not fully 
discharged. Charge the battery then try scanning 
again.
To recharge your SR61B scanner, see “Charging 
the Battery” on page 3.

The Status Light blinks 
red slowly.

The battery is low. Charge the battery.
To recharge your SR61B scanner, see “Charging 
the Battery” on page 3.

You pull the trigger, the 
red scanning beam (1D) 
or laser framing (2D) 
turns on, but you 
cannot successfully scan 
a bar code.

Try these possible solutions:
• Make sure that the SR61B is configured for the 

symbology you are scanning. 
• Make sure that the SR61B is at the appropriate 

scanning distance and angle from the bar code. 
Move the SR61B closer and farther away and 
tilt it up and down to find the appropriate 
distance and angle.

• Make sure that the SR61B is configured for the 
type (1D, 2D) of bar code you are scanning.

• Make sure the bar code you are trying to scan is 
not poorly printed or too small. Scan a known 
good bar code to make sure that the SR61B is 
working properly.

For more information, see “Scanning Bar Codes” 
on page 7.
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You scan a bar code and 
the status light turns 
on, but the SR61B does 
not beep.

The beep duration, volume, frequency, and 
number may be configured so the SR61B does not 
beep. To reset the SR61B, scan this bar code:

Reset factory defaults

You scan a 
(configuration) bar code 
and the SR61B emits six 
very fast beeps. 

The SR61B does not recognize or support the 
configuration bar code you scanned, or has lost 
connection with your host (out of range, low 
battery, disconnected SD61 Base Station cable...). 
Check that the SR61B supports the configuration 
bar code and try to re-establish the Bluetooth 
connection by:
• getting back into range, or
• recharging your scanner, or
• reconnecting the SD61 Base Station cable to 

your host, or
• following the Bluetooth connection procedure 

from start (see “Connecting the SR61B” on 
page 17).

You scan a bar code, the 
SR61B beeps twice, and 
the status light blinks 
green twice, but the data 
is not transmitted to the 
host computer.

Try these possible solutions:
• Make sure that your data collection application 

is set up to receive data from the SR61B.
• If you are using an SD61 Base Station 

connected to your host using an RS-232 cable, 
make sure that the serial parameters on the 
SR61B match the serial parameters of the host 
computer. The default serial parameters for the 
SR61B are: 19200 baud, 8 data bits, no parity, 
and 1 stop bit.

Problems and Possible Solutions (continued)

Problem Possible Solution
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You cannot establish a 
Bluetooth connection 
with your scanner.

There might be a problem with your host 
Bluetooth interface. Try to:
• disable then enable your host Bluetooth radio 

from the Device Manager, or
• unplug then plug again your Bluetooth 

adapter, if applicable, or
• reset the SR61B by reading Reset factory 

defaults bar code.

You are trying to 
establish a Bluetooth 
connection from a host 
device to your SR61B, 
but the host device 
cannot find it.

Try these possible solutions:
• Make sure that the SR61B is in a discoverable 

state.
• Make sure the SR61B is not connected and 

paired to another Bluetooth device. 
In both cases, read the Reset factory defaults bar 
code to reset the SR61B to its default settings and 
disconnect Bluetooth communications. Then try 
establishing a connection again.

You established a 
Bluetooth connection 
with an Intermec 
computer, and the 
settings on your SR61B 
were restored to their 
default values.

When you first connect to an Intermec computer, 
only SR61B settings common to the Intermec 
computer’s internal scanner settings are changed 
to the internal scanner’s default settings. Scan 
configuration bar codes, or use Intermec Settings 
on your Intermec computer to change your SR61B 
settings.

Your scanner is 
unresponsive.

Try to reset or rescue your scanner (see “Resetting 
the SR61B” on page 49).

You cannot scan the 
Firmware upgrade bar 
code on your computer 
screen.

Print out this bar code and scan it:
Firmware upgrade

Problems and Possible Solutions (continued)

Problem Possible Solution
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Maintaining the SR61B
To keep your SR61B in good working order, you may need to upgrade 
the SR61B firmware and clean the scanner window. Should you 
encounter any unresponsiveness, you can electrically reset the 
scanner.

Upgrading the SR61B
You may need to upgrade the SR61B firmware if there is an update 
that incorporates changes to a feature or adds functionality to the 
scanner. When you upgrade your scanner the current settings are 
erased and replaced with the default settings. You need to reestablish 
Bluetooth communications between your SR61B and other Bluetooth 
devices and applications in your data collection system. 

The process of upgrading the SR61B takes about 5 minutes to 
complete.

To upgrade the SR61B you need:

• a Bluetooth interface with your host, such as an internal 
Bluetooth controller or a Bluetooth external adpater.

• Minimum PC operating system requirements are Microsoft® 
Windows® XP with SP2 or Microsoft Windows 2000 with SP4 or 
higher versions.

• EasySet version 5.6.5.3 (see “Configuring Your Scanner with 
EasySet” on page 31) or later with WinFlash.

• The firmware update file (.wbf, Winflash Binary File).

Your scanner can be paired or not with your host prior to upgrading 
it. The following procedures cover both cases.

To upgrade the SR61B firmware when your scanner is already paired 
with your host

1 Download the latest SR61B firmware update package from the 
Intermec web site at www.intermec.com.

Note: Before you start the upgrade process, make sure that you are not 
using the selected COM port for any other application or you receive 
an error and cannot use the COM port.
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a Go to Support > Downloads.

b From the Product Category drop-down list, choose Bar Code 
Scanners. 

c From the Product Family drop-down list, choose Rugged.

d From the Product drop-down list, choose SR61B Handheld 
Scanner and click Submit.

e Click the link to download the firmware upgrade package and 
save firmware upgrade file (.wbf) to your PC.

2 If your scanner is connected to your host, disconnect it by reading 
the Bluetooth Device Disconnect bar code.

Bluetooth Device Disconnect

3 If your host outgoing port is open, close it.

4 If your scanner is paired as an HID Bluetooth device, remove it 
from your host Bluetooth devices and follow the procedure for 
upgrading an unpaired scanner (see “To upgrade the SR61B 
firmware when your scanner is not paired with your host” on 
page 44).

5 Start EasySet version 5.6.5.3 or later. Make sure SR61B is selected 
as your product.

6 From the Tools menu, select Upgrade product firmware to start 
WinFlash.

7 If WinFlash is not already installed or if a more recent version is 
available you will be asked to install it. Click Yes and follow the 
installation instructions. After installing Winflash, start WinFlash 
from the Tools menu, select Upgrade product firmware.

8 Select SR61B 1D scanner or SR61B 2D scanner and click Next.
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9 Use Browse to browse to the location of the firmware upgrade file 
(.wbf), select the file, and click Open. Click Next.
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10 The Firmware upgrade bar code appears. Either read it on screen 
or read the following bar code, then click OK:

Firmware upgrade

11 Select the outgoing Com port. Click Next.

Note: To know which port is the outgoing port, check in the 
Bluetooth option settings or in Windows Configuration Panel, in 
the Device Manager > Ports section.
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12 Click Start download. 

When the firmware download is complete, the “Operation 
successful” message appears.

13 Click Finish. You have successfully upgraded your scanner 
firmware.

To upgrade the SR61B firmware when your scanner is not paired with 
your host

1 Download the latest SR61B firmware update package from the 
Intermec web site at www.intermec.com.

a Go to Support > Downloads.

b From the Product Category drop-down list, choose Bar Code 
Scanners. 

c From the Product Family drop-down list, choose Rugged.

Note: If the firmware download is not successful, you must restart the 
firmware download procedure.
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d From the Product drop-down list, choose SR61B Handheld 
Scanner and click Submit.

e Click the link to download the firmware upgrade package and 
save firmware upgrade file (.wbf) to your PC.

2 Pair your scanner as an SPP Bluetooth device (see “Pairing as an 
SPP Bluetooth Device” on page 24). 

3 Start EasySet version 5.6.5.3 or later. Make sure SR61B is selected 
as your product.

4 From the Tools menu, select Upgrade product firmware to start 
WinFlash.

5 If WinFlash is not already installed or if a more recent version is 
available you will be asked to install it. Click Yes and follow the 
installation instructions. After installing Winflash, start WinFlash 
from the Tools menu, select Upgrade product firmware.

6 Select SR61B 1D scanner or SR61B 2D scanner and click Next.

7 Use Browse to browse to the location of the firmware upgrade file 
(.wbf), select the file, and click Open. Click Next.
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8 The Firmware upgrade bar code appears. Either read it on screen 
or read the following bar code:

Firmware upgrade

9 Select the outgoing Com port. Click Next.
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Note: To know which port is the outgoing port, check in the 
Bluetooth option settings or in Windows Configuration Panel, in 
the Device Manager > Ports section.
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10 Click Start download. 

When the firmware download is complete, the “Operation 
successful” message appears.

11 Click Finish. You have successfully upgraded your scanner 
firmware.

Cleaning the SR61B
Clean the scanner window as often as needed for the environment in 
which you are using the SR61B. To clean the scanner window, you can 
use soapy water, a solution of ammonia and water, or isopropyl 
alcohol.

Note: If the firmware download is not successful, you must restart the 
firmware download procedure.

Opening the SR61B may cause damage to the internal 
components.
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To clean the scanner window 
1 Dip a clean towel or rag in soapy water, ammonia and water 

solution, or isopropyl alcohol and wring out the excess. Wipe the 
scanner window. Do not allow any abrasive material to touch the 
window.

2 Wipe dry with a lint-free cloth.

Recovering the SR61B
The following procedures describe how to reset your scanner when it 
is unresponsive and how to rescue it if you inadvertently set it up in a 
configuration that prevents any extra configuration.

Resetting the SR61B
If your SR61B does not respond when you pull the trigger, you can 
reset it. When you reset your SR61B, the scanner control firmware is 
restarted. 

To reset your SR61B
• Remove and install again the battery from the SR61B.

If you have a Bluetooth connection, the SR61B disconnects from the 
host device. After a reset, the SR61B tries to reestablish a Bluetooth 
connection with the host device when you turn it on.

Rescuing the SR61B
If you cannot configure your SR61B anymore because it is in a locking 
configuration (for example, if you inadvertently disabled the trigger), 
you can rescue it. When you rescue your scanner, factory default 
settings are restored.

To rescue your SR61B
1 Reset your scanner by removing and installing again the battery.

2 Pull the trigger for 10 seconds approximately, until the red LED 
lights up.

3 Release the trigger then press it rapidly five times while the red 
LED is on (2 seconds).

The green LED stays on while the scanner beeps as a confirmation 
(six-beep melody), then the scanner powers off.
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Note: If your scanner does not turn on despite a reset and/or rescue 
procedure, and despite using a correct AB3 battery (P/N 075082-xxx, 
at least partially charged), please contact your Intermec representative.
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Specifications and Reading Distances
This appendix contains the technical specifications and 
reading distances for each scanner model.
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Specifications
Use this section to find technical information about the SR61.

Physical Dimensions

Length 19.4 cm (7.6 in)

Height 13.1 cm (5.2 in)

Width 7.2 cm (2.8 in)

Weight 304 g (10.7 oz) without the battery
Battery = 100 g (3.5 oz)

Power and Electrical Specifications

Operating Rechargeable lithium-ion battery (2400 mAh)

Electrical rating x 5V, 1.7A

ESD sensitivity ± 8 kV (air discharge)
± 4 kV (contact discharge)

Temperature and Environmental Specifications

Operating -20°C to 50°C (-4°F to 122°F) @ 3.3V

Storage -40°C to 70°C (-40°F to 158°F)

Charging 0°C to 35°C (32°F to 95°F)

Relative humidity 5 to 95% non-condensing

Shock 2000G, half sinus, 0.7 ms, 6 directions

Vibrations 8G, from 10Hz to 500Hz, 2hr/axis, 3 axes

Environmental rating IP54

Ambient light 0 to 100 000 lux

Bluetooth Radio

Radio Type Bluetooth Class 1 version 2.1 + EDR
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Frequency 2.4 GHz

Scanning Performance

SR61B1D Scan angle: 40°

Minimum X dimension: 4 mils

SR61BL Scan angle: 38°

Min. X dimension: 4 mils

SR61BHP Scan angles: 34.4° horizontal, 22.2° vertical
Framing angles: 30° horizontal, 20° vertical

Min. X dimension 1D: 4 mils
Min. X dimension 2D: 6.6 mils

SR61BXR Scan angles: 14° horizontal, 8.7° vertical, 16.4° 
diagonal

Min. X dimension 1D: 3 mils
Min. X dimension 2D: 6.8 mils

SR61BDPM Scan angles: 34.4° horizontal, 22.2° vertical
Framing angles: 30° horizontal, 20° vertical

Min. X dimension 1D: 3 mils
Min. X dimension 2D: 6.6 mils

Bar Code Symbologies for 2D Models (SR61BHP and SR61BXR)

Australian Post Infomail

Aztec Intelligent mail

BPO Interleaved 2 of 5

Canada Post Japan Post

Codabar Matrix 2 of 5

Codablock A Maxicode

Codablock F Micro PDF417

Code 11 MSI

Code 39 Muticode

Bluetooth Radio
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* = These symbologies are only available with SR61TL (laser scanner).

Reading Distances
The reading distances for each scanner are typical distances measured 
in an office environment (200 lux).

Code 93/93i PDF417

Code 128 / GS1-128 Planet

DataMatrix Plessey

Dutch Post Postnet

EAN/UPC QR Code

GS1 Composite Standard 2 of 5

GS1 DataBar Expanded Sweden Post

GS1 DataBar Limited Telepen

GS1 DataBar Omni-Directional TLC 39

GS1 DataBar Stacked PDF417

Bar Code Symbologies for 1D Models (SR61B1D and SR61BL)

Codabar GS1 DataBar Omni-Directional*

Codablock A* GS1 DataBar Stacked*

Codablock F* Interleaved 2 of 5

Code 11 Matrix 2 of 5

Code 39 Micro PDF417*

Code 93/93i MSI

Code 128 / GS1-128 PDF417*

EAN/UPC Plessey

GS1 Composite* Standard 2 of 5

GS1 DataBar Expanded* Telepen

GS1 DataBar Limited* TLC 39

Bar Code Symbologies for 2D Models (SR61BHP and SR61BXR)
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SR61B1D

8"

4"

6"

2"

0"

2"

4"

in

0 45403530252015105 50

0" 18"16"14"12"10"8"6"4"2" 20"

6"

8"

10"

10"

cm

10

5

0

5

10

15

20

20

15

25

25

EAN/UPC

0.125 mm/5 mils

0.25 mm/10 mils

0.5 mm/20 mils

1 mm/40 mils

Symbology Density Minimum Distance Maximum Distance

Code 39 0.1 mm (3.8 mils)
0.125 mm (5 mils)
0.25 mm (10 mils)
0.5 mm (20 mils)
1 mm (40 mils)

10 cm (3.94 in)
9 cm (3.54 in)
5.5 cm (2.17 in)
4 cm (1.57 in)
7.5 cm (2.95 in)

14 cm (5.51 in)
17.5 cm (6.89 in)
26 cm (10.24 in)
35 cm (13.78 in)
49 cm (19.29 in)

EAN/UPC 0.33 mm (13 mils) 5.2 cm (2.05 in) 28.5 cm (11.22 in)
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SR61BL
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Symbology Density Minimum Distance Maximum Distance

Code 39 0.125 mm (5 mils)
0.5 mm (20 mils)
1.3 mm (51 mils)

10 cm (3.94 in)
6 cm (2.36 in)
41* cm (16.14 in)

19.5 cm (7.68 in)
85 cm (33.46 in)
150 cm (59.1 in)

EAN/UPC 0.33 mm (13 mils) 4.5 cm (1.77 in) 49 cm (19.29 in)

*Depends on symbology length and scan angle.
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SR61BHP
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0.125mm/5 mils

Symbology Density Minimum Distance Maximum Distance

Code 39 0.125 mm (5 mils)
0.5 mm (20 mils)
1mm (40 mils)

8 cm (3.15 in)
7 cm (2.76 in)
9.5 cm (3.74 in)

14 cm (5.51 in)
46 cm (18.11 in)
70 cm (27.56 in)

EAN/UPC 0.33 mm (13 mils) 6 cm (2.36 in) 32 cm (12.6 in)

PDF417 0.25 mm (10 mils)
0.38 (15 mils)

5.5 cm (2.17 in)
6.5 cm (2.56 in)

26 cm (10.24 in)
36 cm (14.17 in)

DataMatrix .025 mm (10 mils) 6 cm (2.36 in) 21 cm (8.27 in)
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SR61BXR
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Symbology Density Minimum Distance Maximum Distance

Code 39 0.25 mm (10 mils)
0.5 mm (20 mils)
1 mm (40 mils)
1.3 mm (51 mils)
2.5 mm (100 mils)

16 cm (6.3 in)
16 cm (6.3 in)
* cm
* cm
* cm

110 cm (3.6 ft)
200 cm (6.6 ft)
450 cm (15 ft)
600 cm (20 ft)
870 cm (28.5 ft)

EAN 100% 0.33 mm 20 cm (7.87 in) 140 cm (4.6 ft)

DataMatrix 0.25 mm (10 mils)
1.4 mm (55 mils)
2.5 mm (100 mils)

16 cm
* cm
* cm

80 cm (2.6 ft)
400 cm (13.1 ft)
800 cm (26.2 ft)

*Depends on symbology length and scan angle.
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SR61BDPM
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Symbology Density Minimum Distance Maximum Distance

Code 39 0.076 mm (3 mils)
0.1 mm (4 mils)
0.125 mm (5 mils)
0.5 mm (20 mils)
1 mm (40 mils)

5.5 cm (2.17 in)
5 cm (1.97 in)
5 cm (1.97 in)
7.5 cm (2.95 in)
* cm

9 cm (3.54 in)
10.5 cm (4.13 in)
12 cm (4.72 in)
23 cm (9 in)
36 cm (14.17 in)

EAN 100% 0.33 mm 6 cm (2.36 in) 18 cm (7.09 in)

PDF417 0.125 mm (5 mils)
0.25 mm (10 mils)
0.38 (15 mils)

5 cm (1.97 in)
4 cm (1.57 in)
6 cm (2.36 in)

12.5 cm (4.92 in)
16.5 cm (6.5 in)
20.5 cm (8.07 in)

DataMatrix 0.125 mm (5 mils)
0.25 mm (10 mils)

5.5 cm (2.17 in)
4.5 cm (1.77 in)

10.5 cm (4.13 in)
14 cm (5.51 in)

*Depends on symbology length and scan angle.
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